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Overview
Tanium Comply™ (Comply) allows users to support their enterprise compliance goals at
Tanium speed. Comply is primarily used for operating system-level checks and scales
using the Tanium architecture. It features the following benefits:
l

l
l
l

Evaluates Benchmarks and vulnerabilities against operating systems, network
configuration, password policy, file permissions, and other components
Supports Windows, Linux, and macOS platforms
Supports Center for Internet Security (CIS) content
Enables custom checks and result mapping

Comply terminology
The following are definitions of terms used in Comply:
Security Content Automation Protocol (SCAP)
Comply uses SCAP content to perform compliance checks. These specifications
are derived from the input of a community of industry professionals working to
advance automation and standardization of technical security operations.
Extensible Configuration Checklist Description Format (XCCDF)
Collection of security configuration rules (primarily composed of OVAL checks)
applied against endpoints. XCCDF does not include commands to perform the
scan; it is mostly descriptive. Rule evaluation is defined in OVAL. XCCDF files are
sometimes called benchmarks or checklists.
Open Vulnerability and Assessment Language (OVAL)
A declarative language that defines how a rule is evaluated. OVAL makes logical
assertions about the state of a system and is used to describe security
vulnerabilities or desired configuration of systems.
Common Vulnerabilities and Exposures (CVE)
A public database of known vulnerabilities.
Vulnerability source
A path to a local Open Vulnerability and Assessment Language (OVAL) definitions
file or a URL to a remote OVAL definitions file.
Custom check
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An arbitrary powershell, VBScript, or UNIX shell script used to evaluate conditions
on an endpoint.
Custom ID mapping
Maps custom check ID or XCCDF rule ID to arbitrary value. Helpful in mapping
CIS content to some other policy or associating arbitrary tags with rules.
Report
A package containing a zip file of all XCCDF benchmarks, custom check scripts,
custom profile definitions, and optional custom ID mapping definition. A report
includes the Action to distribute to selected Computer Groups as well as the Saved
Question to retrieve scan results from endpoints.

Scheduling Actions in Comply
When the scheduling option is available in Comply functions, such as when you create
reports, the following fields are available:

Field

Value

Schedule

Select either Run Once or Recurring.

Start at
End at

When Recurring is selected for Schedule, complete these
fields to limit the report to run only during a specific time
period.

Distribute
over

Select and enter values to run the report over minutes, hours,
or days.
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Field

Value

Reissue
every

Select and define the interval in minutes, hours, or days in
which the report will run.
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Getting started
1. Install Comply. For more information, see Installing Comply on page 12.
2. Create Computer Groups. For more information, see Creating Computer Groups on
page 19.
3. Create deployments. For more information, see Creating deployments on page 20.
4. Work with Benchmarks. For more information, see Working with Benchmarks on
page 25.
5. Create reports. For more information, see Creating reports on page 33.
6. View, edit, or delete reports. For more information, see Working with reports on
page 38.
7. Deploy Custom Checks and use Custom ID Mapping. For more information, see
Deploying Custom Checks and using Custom ID Mapping on page 46.
8. Create Custom Profiles. For more information, see Creating Custom Profiles on
page 51.
9. Remove Comply content and tools from endpoints. For more information, see
Deleting Comply content from endpoints on page 61.
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Requirements
Licensing
Comply is licensed for installation as a component of the Tanium Server. To obtain a
license, see your Tanium Technical Account Manager (TAM).

System requirements
l
l
l
l
l
l

Microsoft Windows 7 or later
Microsoft Windows Server 2008 or later
Red Hat Enterprise Linux and CentOS 5 through 7
Debian 7 and 8
Ubuntu 12.04 and 14.04
Apple Mac OS X 10.11

Installation prerequisites
Before installing Comply, you need to have a service account with Tanium Administrator
credentials. You must also have the Tanium Module server running.
You must be a member of Center for Internet Security (CIS) in order to download the
tools you need to use Comply to run CIS scans.
You must be a part of the United States government to use the Security Content
Automation Protocol (SCAP) Compliance Checker (SCC) scan engine. If you are part of
a government organization, consult with your TAM on how to obtain the appropriate
SCC bundles.
Endpoints to be scanned either need to have Java already installed or be provided with
a Java Runtime Environment (JRE) via Comply. The JRE can be downloaded from
www.oracle.com/technetwork/java/javase/downloads/index.

User roles
The following user roles are supported in Comply:
Question Author
Can view reports, drill down into reports, and create report exports.
Content Administrator
Has all privileges in Comply with the exception of installing or uninstalling Comply.
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Administrator
Has all privileges in Comply, including installing or uninstalling Comply.

Center for Internet Security Benchmarks and tools
Tanium Comply assesses endpoints using Center for Internet Security (CIS)
Benchmarks and the Center for Internet Security Configuration Assessment Tool (CISCAT) tool, both of which are available to members of CIS. You will need to download the
Benchmark bundle from CIS before getting started with Tanium Comply.
Note: Comply does not currently support any checks that require authentication
such as database server scans and does not provide its own compliance scanning
engine.
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Installing Comply
Before installing Comply, refer to Getting started on page 9. The installation of Comply is
done from the Tanium Console.

Import Solution
1. Log into the Tanium Console using an account with Administrator privileges.
2. Select Tanium Solutions from the main menu.

3. Click Import X.X.X.X (where X.X.X.X is the current module version number) under
Comply.
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Note: Tanium Comply is a Tanium licensed solution. Contact your TAM to
obtain a license if you do not have one.
4. If you are prompted, click Proceed with Import. Enter your credentials. This begins
the Tanium Comply installation and configuration process.
After the Tanium Comply installation and configuration process completes, you see the
message Import completed successfully, and Comply appears in the main menu.

Upgrade Comply
When there is a new version of Comply available, you will be prompted to Upgrade to
X.X.X.X (where X.X.X.X is the new module version number) under Comply on the
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Tanium Solutions page. The upgrade steps are the same as the import steps.

IMPORTANT: When you upgrade Comply, a red error message will be displayed
if a deployment's tools are out of date. To deploy the latest tools to deployments
with this error, click Redeploy. This will upgrade the tools on endpoints to the
latest version the next time the tools installation Action runs.

Set up Comply
1. From the main menu, select Comply. The Home page shows setup status. If no
reports and deployments are configured, you will be prompted to go to the Setup
page. Otherwise, you will see the four most recent reports and the three most
recent deployments.
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2. Select Setup under the Home menu. The Setup page summarizes the steps
required to get started with Comply.

Import scan engines
Comply does not ship with its own scan engine, so you must upload a scan engine
before using Comply. Scan engines are used to evaluate OVAL or SCAP content and
generate Configuration Compliance and Vulnerability reports. At least one scan engine
is required to use Comply, but more than one can be uploaded and used if desired.

Download and import the CIS engine
1. Go to https://community.cisecurity.org and log in or click Register if this is the first
time you are using CIS Security benchmarks.
2. Go to the CIS-CAT Downloads page to download the latest ciscat-full-bundle.zip
file. You can also get to this page once you are logged in by clicking Downloads in
the top menu and clicking Tools: CIS-CAT in the right margin.
3. In Comply, select Engines under the Setup menu.
4. On the Manage Engines page, click Upload Engine/JRE on the top right.
5. In the Engine Type drop-down, select CIS-CAT.

6. Click Select File to select the zip file you downloaded from CIS.
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7. Check Import Benchmarks to import the Benchmarks in the bundle into Comply.
Tanium recommends that you check this option. This option will be enabled by
default the first time you upload the CIS-CAT bundle.
8. Uncheck Import Engine if you have already imported the required engine and you
only want to import benchmarks (see note below).
9. Click Upload.
Note: In order to upgrade your benchmarks when CIS releases a new version of
the bundle, select Import Benchmarks only. This is how new, updated
benchmarks are imported into Comply in bulk. Existing reports and benchmarks
will be not affected by this process, and the benchmarks used in these reports are
not automatically upgraded to the new versions of the respective benchmarks.

Import the SCC scan engine
SCC is the scan engine used by the United States government; it is not available to the
general public. If you are part of a government organization, consult with your TAM on
how to obtain the appropriate SCC bundles.
Note: Within each SCC zip file, there is another zip (on Windows) or a tar.gz file
(on Linux/OS X). Comply will accept these inner zip or tar.gz files as well as the
original zip archive. This reduces the amount of data in half that you must upload.
1. Select Engines under the Setup menu.
2. On the Manage Engines page, click Upload Engine/JRE on the top right.
3. In the Engine Type drop-down, select SCC.

4. Click Select File to select the the SCC bundle that you would like to upload.
5. Click Upload.
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Note: Some SCC bundles come packaged with DISA STIG benchmarks. To
import these, be sure to check Import Benchmarks. Not all SCC bundles include
this content.

Download and import the Java Runtime Environment (JRE) package
Go http://www.oracle.com/technetwork/java/javase/downloads/index and download the
appropriate Java Runtime Environment (JRE) package for each platform and
architecture required for the endpoints in your environment. The standard JRE and
server JRE are supported. JDK packages are not supported. Be sure to download the
tar.gz packages, not the exe, rpm, or dmg files.
Note: If you already have the appropriate JRE package(s) installed, you may not
need to download additional JRE packages. Tanium recommends using Comply
to install a JRE and not using a pre-installed JRE so that you are sure which JRE
is being used to run scans.
1. Select Engines under the Setup menu.
2. On the Manage Engines page, click Upload Engine/JRE on the top right.

3. In the Engine Type drop-down, select Java runtime.
4. Click Select File to select one of the JRE tar.gz files that you downloaded
earlier.
5. Click Upload.
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Note: You can remove engines and JREs from the Manage Engines page by
clicking Remove.

Download and import Joval
Note: In order to use Joval, you must have a license and the Joval engine zip file
downloaded.
1. Select Engines under the Setup menu.
2. On the Manage Engines page, click Upload Engine/JRE on the top right.
3. In the Engine Type drop-down, select JovalCM.

4. Click Select File to select the Joval engine file.
5. Click Upload.
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Creating Computer Groups
Comply will automatically target platform and architecture; however, if you need to run
benchmarks or push deployments against endpoints with a specific operating system or
on a specific subnet, you need to create Computer Groups. Define Computer Groups in
the Administration section of Tanium™ Console. See Tanium Platform User Guide:
Managing Computer Groups.

Examples of Computer Groups
Following are examples of Computer Groups for operating systems created by selecting
the appropriate query suggested by Tanium's language parser:
Operating System

Query

Windows

Operating System containing “Windows Server 2012 R2”

Linux

Operating System containing “CentOS release 6.3 (Final)”

OS X

Operating System containing “Mac OS X (10.11.6)”
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Creating deployments
1. Select Deployments under Setup.
2. On the Setup Deployments page, click Create Deployment on the top right.

3. Provide a Description.
4. Select a Platform and Architecture.
5. Select or deselect Engines you have imported. You are able to select multiple
engines in this field.
6. Select Computer Groups you want to target with the deployment. You are able to
select multiple Computer Groups in this field.
7. Refer to Scheduling Actions in Comply on page 7 for an explanation of the Start
at, End at, Distribute over, and Reissue every fields.
8. Click Create & Deploy. You will see the Action progress and Installation status of
your deployment.
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Using JRE encryption
Use JRE encryption to prevent access to the JRE. This will encrypt the zip file on the
endpoint that contains the JRE, and a key file is distributed with reports that require the
JRE to decrypt it. Once the report runs, the key file and decrypted JRE are removed. The
encrypted JRE remains so it can be used the next time it is required.
1. Complete all of the fields in the Create Deployment window and select a JRE in
the Engines field.
2. Select Encrypt JRE.
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3. Click Create & Deploy. On the Reports page, any report with an encrypted JRE
will show a lock next to that engine.
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Working with deployments
To redeploy, delete, or see the status of a deployment, select Deployments from the
Setup menu.
When you redeploy a deployment, you can view the Action progress and Installation
status.
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Click on the information
that deployment.

icon next to Target to see the target Computer Groups for

Legacy Deployments
On the Setup Deployments page, click Remove to delete Legacy Deployments that are
obsolete. Removing legacy deployments will stop/remove the old action and package
associated with these deployments. You may need to create a new deployment that
matches the legacy deployment to ensure that engine/JRE selections are deployed as
previously.
Note: Tanium recommends that you remove legacy deployments.
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Working with Benchmarks
Note: Before you can work with Benchmarks, you must import them. See
Download and import the CIS engine and Installing Comply on page 12 for
instructions on how to import or upgrade Benchmarks in bulk.
After importing engine files, you can view imported Benchmarks to verify that they have
been imported. Select Configuration Compliance or Vulnerability under Benchmarks to
view each type of imported Benchmark.

Configuration Compliance Benchmarks
Importing individual Benchmarks and assigning Categories
1. On the Configuration Compliance page under Benchmarks, click Import
Benchmark to import additional Configuration Compliance Benchmarks.

2. Provide a Description for the Benchmark.
3. Assign an existing Category to the Benchmark or create a new Category to help
organize your Benchmarks. Select a Category from the Category drop-down list or
select Create new category... to create a new Category to assign to the Bookmark.
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4. Enter any custom tags in the Tags field to further describe and categorize the
Benchmark.
Note: When Benchmarks are imported with an engine, such as CIS-CAT or
SCC, they are automatically assigned the applicable category. By default,
new Benchmarks are assigned the Imported Category.
5. If you've chosen to create a new Category, in the Create Category window, enter a
name for your new category and click Save.

You can also view all Categories and create a new Category from the Tools menu.
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1. Click the wrench icon

on the far right of your screen.

2. From the Tools menu, select Manage Benchmark Categories.

3. On the Benchmarks Categories page, click New Benchmark Category.
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4. In the New Benchmark Category window, enter a name for your new category and
click Save.

FILTER BENCHMARK CATEGORIES

You can filter Benchmarks by Category on the Configuration Compliance Benchmarks
page under Benchmarks by selecting a Category in the Category drop-down list.

DELETE BENCHMARK CATEGORIES

1. From the Tools menu, select Manage Benchmark Categories.
2. On the Benchmark Categories page, select a Category and click on the trashcan
icon
to delete a Category. You can only delete a Category that contains no
Benchmarks.
CHANGE A BENCHMARK CATEGORY OR TAGS

1. On the Configuration Compliance Benchmarks page, hover over a Benchmark
and you will see the Change Category/Tags button.
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2. In the Benchmark Metadata window, select a different Category and edit Tags.

3. Click OK.

Filtering Benchmarks
Use the Tag Filter field at the top right of the Configuration Compliance Benchmarks
page to filter the Benchmarks. Begin entering text to see a list of available tags or click
the X next to an existing tag to remove it from the list of filters.
The green supported tag indicates that Tanium has tested the Benchmark. Only
supported Benchmarks are shown by default. Benchmarks indicated with a yellow
unsupported tag are Benchmarks that Tanium has not tested. This does not mean that
the Benchmark does not work; it has just not been tested by Tanium.

Viewing Benchmark profiles and creating reports
1. Click the arrow icon
Benchmark.

to expand the details of a Configuration Compliance

2. Under the Profiles section, click Create Report next to a Benchmark profile to
create a report for that profile. Clicking Create Report at the top right creates a
report for the first profile listed. The Name, Platform, Benchmark, and Profile fields
are auto-populated based on the Benchmark and profile you selected. These
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values can be changed.

3. Select the Computer Groups you want to target.
4. Select either Run Once or Recurring for the Schedule. If you select Recurring,
refer to Scheduling Actions in Comply on page 7 for an explanation of the fields
available for this option.
5. Click Create & Deploy to run the report.

Vulnerability Benchmarks
Create a new Vulnerability Source
1. Click Create Source on the top right of the Vulnerability Benchmarks page.

2. In the Details section, provide a Name, Vendor, and Description.
3. In the OVAL Definitions File section, choose either Remote or Local for the
Location.
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Note:
A remote source is a URL that points to an OVAL definition XML file. A local
source is an absolute path to a file on the Tanium Module Server. Either
source can be updated by simply clicking Download Updates where the
Benchmark is listed on the Vulnerability Benchmarks page.
Remote sources are best suited when OVAL content is updated periodically.
Local sources are best suited to air gapped environments or when you would
like to manually download and provide the source feed.
This OVAL definition file from CIS provides access to all vulnerability
definitions in their repository:
https://oval.cisecurity.org/repository/download/5.11.1/all/oval.xml
4. Enter the path in the Remote File or Local File field as appropriate.
5. Enter the Batch Size.
Note: The Batch Size defines the number of checks that will run at a time.
The default value for this field is 500 in order to run a manageable number of
checks on your endpoints. Consult with your TAM if you want to adjust this
value.
6. Click Save.

Edit a Vulnerability Source
On the Vulnerability Benchmarks page, you can also select the gear icon
vulnerability source or the trashcan icon
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Perform a Vulnerability scan
1. Click the arrow icon to expand the details of a Vulnerability Benchmark to view
information about the associated XML file and operating systems. Click Create
Report at the top right or next to any of the operating systems to create a new
Vulnerability Report.

2. If you click Create Report next to an operating system, then the Platform and
Operating System are automatically populated on the New Vulnerability Report
page. In the Details section, provide a Name and Description.
3. Select the Computer Groups you want to target.
4. Select either Run Once or Recurring for the Schedule. If you select Recurring,
refer to Scheduling Actions in Comply on page 7 for an explanation of the fields
available for this option.
5. Click Create & Deploy to run the vulnerability scan.
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Creating reports
Note: Comply works best with operating system-level checks. See Creating
Computer Groups on page 19.
You can create a new report on the Reports page or create one using an existing
benchmark on the Benchmarks page.
Run a Compliance Configuration report to check the security configuration compliance
state of a group of machines. This will execute reports using SCAP XCCDF
benchmarks. Run a Vulnerability report to execute OVAL checks against your endpoints
to check for the presence of identified vulnerabilities.

Create report from the Reports page
Create a Configuration Compliance Report
1. Select Reports from the main menu.

2. Select Configuration Compliance Report from the Create Report drop-down list.

© 2017 Tanium Inc. All Rights Reserved

Page 33

3. On the New Configuration Compliance Report page, enter a Name for the report
in the Details section. You can also provide a Description.

4. Select a Platform.
5. Select the Engine. You will only see the Engine field if you have more than one
engine installed.
6. The Tanium Comply Action Group is created automatically by Comply and will be
auto-populated in the Action Group field. All saved Actions created by Comply will
be created under this Action Group.
7. Select Computer Groups.
IMPORTANT: Be sure to select the appropriate platform (Windows, Linux, or
OS X) and Computer Groups containing endpoints that align with the
Platform for Comply to work correctly.
8. Select either Run Once or Recurring for the Schedule. If you select Recurring,
refer to Scheduling Actions in Comply on page 7 for an explanation of the fields
available for this option.
9. Select the Benchmark and Profile from the drop-down lists in the Benchmarks
section.
10. Click + Add Additional Benchmark to add another benchmark or click Create &
Deploy and enter your credentials. Action results will display.
11. If you have Custom Checks or Custom ID Mappings, you can specify these in the
Advanced section. See Deploying Custom Checks and using Custom ID Mapping
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on page 46 for more information.

Create a Vulnerability Report
1. Select Reports from the main menu.

2. Select Vulnerability Report from the Create Report drop-down list.
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3. On the New Vulnerability Report page, enter a Name for the report in the Details
section. You can also provide a Description.

4. Select a Platform.
5. Select the Engine. You will only see the Engine field if you have more than one
engine installed.
6. The Tanium Comply Action Group is created automatically by Comply and will be
auto-populated in the Action Group field. All saved Actions created by Comply will
be created under this Action Group.
7. Select Computer Groups.
IMPORTANT: Be sure to select the appropriate platform (Windows, Linux, or
OS X) and Computer Groups containing endpoints that align with the
Platform for Comply to work correctly.
8. Select either Run Once or Recurring for the Schedule. If you select Recurring,
refer to Scheduling Actions in Comply on page 7 for an explanation of the fields
available for this option.
9. Select the Source and Operating System from the drop-down lists in
the Vulnerability Source section.
10. Click Create & Deploy and enter your credentials. Action results will display.

Create a report from the Benchmarks page
1. Select Benchmarks from the main menu and expand the benchmark for which you
want to create a report by clicking the arrow icon

.

2. Under the Profiles section, click Create Report next to the benchmark profile for
which you want to create a report.
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3. Follow the steps in Create report from the Reports page on page 33 and run the
report. The Name, Benchmark, and Profile fields are auto-populated based on the
Benchmark and Profile you previously selected. These values can be changed.
Note: You can also create a report for a Configuration Compliance Benchmark
when you hover over a Benchmark on the Configuration Compliance
Benchmarks page and click Create Report. You will have to select the
appropriate Profile.

IMPORTANT: The Platform field is not auto selected. Be sure to select the
appropriate platform (Windows, Linux, or OS X) and Computer Groups containing
endpoints that align with the Platform for Comply to work correctly.

© 2017 Tanium Inc. All Rights Reserved

Page 37

Working with reports
View results
Select Reports from the main menu to view the results for All reports, Configuration
Compliance reports, or Vulnerability reports that have been run and if/when they are
scheduled to run again.
Click the Interact icon
next to Endpoints Analyzed to go to Interact to view any
endpoints reported on that are currently online.

Click on the information
that report.

icon next to Target to see the target Computer Groups for

Click on a report to see details and results associated with that report and details about
the policies included in Configuration Compliance reports and questions included in
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Vulnerability reports.

Click on a rule to see a detailed description of that rule.

When a report is loading, it may take some time to display results as they are retrieved
from the Tanium server. To see results immediately as they load, click Refresh Results.

View scheduled reports
You can view reports that are scheduled to run on the Tanium Comply Action Group in
the Tanium Console.
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1. Select Scheduled Actions under Actions from the main menu.

2. On the Actions page, enter Comply in the search field and select Tanium Comply to
see the Reports scheduled to run on the Tanium Comply Action Group.

Selecting the Tanium Comply Action Group shows all scheduled actions for Comply,
including engine/JRE scheduled actions as well as those created for report execution.
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Run a report again
1. Select Reports from the main menu and click on the report you want to run.
2. Click Deploy Now to run that report again.

Export report results
1. On the Reports page for All, Configuration Compliance, or Vulnerability, select a
report.
2. Under the Report Options drop-down list at the top right, click Export Results.
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3. In the Export Report window, provide a Title and Description for the report.

4. Choose either HTML or CSV from the Format drop-down list for the exported data.
5. By default, pass, fail, and error report types are already selected. Click in the
Report Types field to select additional types or to remove any of the default types.
6. Select options for Results Display and Rule Details. Results Display can be used
to turn off the summary values for each result so that the endpoint list will the
complete list of computer names and IP addresses.
7. Click Export. Enter your credentials and click OK.
Note:You can close the Export Report window and let the report export
process run in the background. Go to the Report Export page to view the
progress of any report export jobs currently running. The last column in the
results table on indicates the status of the report export job..
8. When the export report is complete, click View report export to go to the Report
Exports page or click Download to download the report in the format you selected.
9. On the Report Exports page, select a report and click the download icon
download it.

to

Edit report schedules
1. Select Reports from the main menu.
2. Hover over a Report name and click on the calendar icon
schedule for that Report.
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3. Refer to Scheduling Actions in Comply on page 7 for an explanation of the fields
available in the Edit window.

4. Click Save.

Delete a report
Note: You cannot edit the content of a Report once it has been created, and you
cannot delete a Benchmark, Custom Check, or Custom ID Mapping if they are
associated with a Report. You can only change when a Report runs per Edit report
schedules on page 42.
When an updated version of a new Benchmark is released, you must delete the Report
that used the old Benchmark and create a new report with the updated Benchmark.
1. Select Reports from the main menu and hover over a Report name.
2. Click on the trashcan icon

to delete that Report from your list of Reports.

3. See Deleting stale reports from endpoints on page 43 to remove the Report from
the endpoints.

Deleting stale reports from endpoints
If you have deleted a Report using the procedure described in Delete a report on page
43, you still need to delete it from the endpoint(s).
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1. Click the wrench icon

on the far right of your screen.

2. Select Manage Stale Reports from the Tools menu.

3. The Stale Reports window will appear and provide a list of Reports that are no
longer known to comply. Select the Report you would like to remove. Refer to
Scheduling Actions in Comply on page 7 for an explanation of the scheduling
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fields available in the Stale Reports window.

4. Click Remove Selected.
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Deploying Custom Checks and using
Custom ID Mapping
Custom Checks
You can create custom checks in Comply to check a condition on endpoints that may not
be included in any Benchmark. A custom check can be either PowerShell or VBScript
on Windows and bash shell scripts on Linux/OS X. PowerShell scripts should use the
file extension .ps1, and VBScript files should use the .vbs extension.
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1. Click the wrench icon

on the far right of your screen.

2. Select Manage Custom Checks from the Tools menu.

3. On the Custom Checks page, click New Custom Check.
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4. Complete the Title, Description, Identifier (can be used to trace back to
corresponding Custom ID Mapping), and the optional Severity fields in the New
Custom Check window.
5. Select the appropriate Platform (Windows or Linux).
6. Click Select File and locate the file for the custom check.

7. Click Save. Your custom check will now appear on the Custom Checks page and
in the Advanced section of the New Report page when you create a new report.

Note: Custom checks should take less than a minute to run – they can output
anything to standard output as long as the last line is a valid rule result string such
as pass, fail, or error.

Custom ID Mappings
Custom ID Mappings allow you to create a custom column on results that associates a
specific tag with a custom check or rule identifier.

© 2017 Tanium Inc. All Rights Reserved

Page 48

1. Click the wrench icon

on the far right of your screen.

2. Select Manage Custom ID Mappings from the Tools menu.

3. Click New Custom ID on the Custom IDs page.

4. Enter a Name and Description in the New Custom ID window.
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5. Click Select File and locate the Custom ID mapping file.

6. Click Save. Your Custom ID will now appear on the Custom IDs page and in the
Advanced section of the New Report page when you create a new report.

Following is the file format used for a Custom ID Mapping: Rule id | custom id
Example: xccdf_org.cisecurity.benchmarks_rule_1.1.1_Create_
Separate_Partition_for_tmp|company_policy_rule_42
Note: A Report can only have a single Custom ID Mapping associated with it;
however, it can have multiple Benchmarks and Custom Checks. When selecting
the Benchmarks and Custom Checks, be aware that a Report is targeted to a
single Action Group.
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Creating Custom Profiles
A profile defines a set of rules to be evaluated and the parameters for those rules.
Custom Profiles allow you to specify just a subset of the checks available in a
benchmark to be deployed.
To create a Custom Profile
1. Click the wrench icon

on the far right of your screen.

2. From the Tools menu, select Manage Custom Profiles.
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3. On the Custom Profiles page, click New Custom Profile.

Note: A Custom Profile can also be specified with a tailoring file. For more
information about tailoring files, see NSIT's Technical Specification for the
Security Content Automation Protocol (SCAP) or consult with your TAM.
4. On the New Custom Profile page, enter a Title.

5. Enter an ID that matches the following regular expression: xccdf_[^_]+_
profile_.+.
Example: xccdf_customprofile_profile_1
6. Enter a Description.
7. In the Rules section, select a Benchmark from the Benchmark drop-down list.
8. Select each rule you would like to include in your Custom Profile.
9. Click Add Selection to Profile to move the selected rules to the Selected Rules
section. You can click Remove Selection From Profile to remove any rules you
have added.
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10. Click Create to create the new Custom Profile.

You can also modify some rule values within your Custom Profile. If a rule value is
customizable, a value of true will appear in the Can Customize column along with the
default value for the rule in the Default Value column.
To customize a rule value
1. Select the rule and click Modify Rule Value.
2. In the Modify Custom Profile Value window, enter a Custom Rule Title and
change the Custom value field.

Note: Rule titles occasionally include the value used in the rule. Customize
the title of rules for which values have been changed. The customized rule
titles will then show up in report results, question answers, and report
exports. For example, If you provide a new value for the rule (L1) Ensure
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'Enforce password history' is set to '24 or more password(s), you can
change 24 to match the custom value.
3. Click Save. The new value will appear in the User-defined Value column. You can
return to the Default Value of a rule by clicking Use Default.
On the Custom Profiles page, select a Custom Profile and click Show Details to view
Custom Profile Details.

You will see the rules included in the Custom Profile as well as those for which the
values have been modified.
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Managing Comply settings
Consult with your TAM before changing any Comply settings to better understand
implications of changing setting values.
To manage Comply settings
1. Click the wrench icon

on the far right of your screen.

2. Select Manage Settings from the Tools menu.

3. To edit a setting, click the setting and then click Edit.
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4. Enter a Value and click Save.

Note: Comply settings are configured by Tanium and set to default values. Users
cannot create settings. If you click the trashcan icon
entered Value, not the setting.

© 2017 Tanium Inc. All Rights Reserved

, you will only delete any

Page 56

Troubleshooting
IMPORTANT: Do not manually delete any Tanium content that includes “Comply”
in the name for any reason. This can cause Comply to stop working correctly.

Collect logs
You may need to collect logs associated with Comply for troubleshooting purposes
when working with technical support or your TAM.
To collect logs
1. Click the information icon

on top left of the screen.

2. Click Collect to download logs. And then click Download to obtain a support
bundle of files to provide to your TAM or technical support.

Locate log files
You may need to locate log files on your endpoint or on the Tanium Module Server for
troubleshooting purposes when working with technical support or your TAM.
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Endpoint log files
Comply log files are created on endpoints at the following path: C:\Program Files
(x86)\Tanium\Tanium Client\Tools\Comply\logs
Log files for each scan are keyed by report hash. Only the most recent file is kept.

Tanium Module Server log files
Comply log files are created on the Tanium Module Server at the following path:
C:\Program Files\Tanium\Tanium Module Server\services\complyservice\logs
Service log files are found here.

Recreate JRE encryption key
If a JRE encryption key is lost or overwritten, Comply allows you to recreate the JRE
encryption key.

© 2017 Tanium Inc. All Rights Reserved

Page 58

1. Click the wrench icon

on the far right of your screen.

2. From the Tools menu, select Manage JRE Encryption Key.

3. In the Change JRE Encryption Key window, click Rekey to generate a new JRE
encryption key.
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Note: You can provide your own encryption key; however, Tanium
recommends that you do not enter anything in the Leave blank to have your
new key generated by Tanium field.
4. Enter your credentials and click OK.
IMPORTANT: If you have existing reports on endpoints with an encrypted
JRE, those reports must be redeployed. In addition, all existing encrypted
deployments must be redeployed so they are updated with the new key.
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Deleting Comply content from endpoints
If you decide to uninstall Comply or want to remove Comply content and tools from an
endpoint, use the Comply Remove Client Files actions. There is one for Windows and
one for Unix (Linux/OS X).
To remove Comply content and tools
1. Select Interact from the main menu.

2. Enter a query to target the endpoints from which you want to remove Comply
content and tools. For example, enter Get online from all machines if you want to target
all endpoints that are online. Select the appropriate query suggested by Tanium’s
natural language parser.
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3. Check True and then click Deploy Action.

4. On the Deploy Action page, enter Comply in the Enter package name here field.
5. Select either the Comply - Remove Client Files - Windows or Comply - Remove
Client Files - Unix action, as appropriate, to the the endpoints where you wish to
remove Comply content and tools. Refer to Tanium Platform User Guide:
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Managing Scheduled Actions for more information.
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6. Check Remove ALL Comply files if you want to remove all Comply content and
tools or check just the content and tools you want to remove.

7. Click Show preview to continue at the bottom of the Deploy Action page.
8. A results grid will appear at the bottom of the page showing you the targeted
endpoints for your Action. If you are satisfied with the results, click Deploy Action.
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